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Module: Projects 

A services business, which doesn't have a tangible product to showcase their value needs to get many 
things right in order to stay afloat and grow in the industry. ERP+ helps services company effectively 
manage business aspects like projects management, customer support, sales, and purchase 
management to list a few. You can look at the following topics after going through this introduction. 
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1. Topics 

1.1 Project Management 

1. Project 
2. Tasks 
3. Project Template 

1.2 Time Tracking 

1. Salary Slip from Timesheet 
2. Sales Invoice from Timesheet 
3. Timesheet Against Work Order 
4. Timer in Timesheet 
5. Timesheet Against Project 
6. Activity Type 
7. Activity Cost 
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2. Articles 

1. Project Costing 
2. Project Profitability 
3. Project Expenses 
4. Project Customer Portal 



 

 

 

 

 

 

 

1.1 Topic: Project Management 
 

1. Project 
2. Tasks 
3. Project Template 
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1. Project Management 

The project is an individual or collaborative enterprise, possibly involving research or design, 
that is carefully planned, usually by a project team, to achieve a particular aim 

In ERP+, Project management in is Task driven. You can a create Project and divide into multiple 
and assignable Tasks. 

 

Managing Tasks 
The project generally has a broader scope, and hence not assignable to an individual. Hence, 
you can divide the Project into multiple Tasks. These can be assigned to an individual and 
tracked better. 

These Tasks can be created from a Project itself or a Task can be created separately as well. 
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Task Completion 
You can also track % Completion of a Project using different methods. 

1. Task Completion 
2. Task Progress 
3. Task Weight 

 

Some examples of how the % Completion is calculated based on Tasks. 

 

 

Project Costing 

The Project Costing section helps you track the time, expenses and purchases incurred against 
the project. 

• The Total Cost is composed of the costing amount from timesheets, the total cost of 
expense claims and the total cost of purchase invoices created against this project. 

• The Gross Margin is the difference between Total Billed Amount and the Total Cost 
Amount for this project. 
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Gantt Chart 

ERP+ gives you an illustrated view of tasks scheduled for that project in Gantt Chart View. 

• To view Gantt chart against a project, go to the Task list and Apply filter on the Project. 

 

Tasks 

Project is divided into Tasks. In ERP+, you can also create a Task independently. 
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Status of the Task 
A Task can have one of the following statuses - Open, Working, Pending Review, Closed, or 
Cancelled. 

 

• By default, each new Task created has the status set to 'Open'. 
• If a Time Log is made against a task, its status will be set to 'Working'. 

Dependent Task 
You can specify a list of dependent tasks under the 'Depends On' section. 

 

• You cannot close the parent task until all dependent tasks are closed. 
• If the dependent tasks are delayed and overlap with the expected Start Date of the Parent 

task, the system will reschedule the parent task. 

Managing Time 
ERP+ uses Time Log to track the progress of a Task. You can create multiple Time Logs against 
each task. The Actual Start and End Time along with the costing is updated based on the Time 
Log. 

• To view Time Log made against a Task click on 'Time Logs' 
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• You can also create a Time Log directly and link it to the Task. 

 

Managing Expenses 
You can book Expense Claim against a task. The system shall update the total amount from 
expense claims in the costing section. 

• To view Expense Claims made against a Task click on 'Expense Claims' 

 

• You can also create an Expense Claims directly and link it to the Task. 
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• Total amount of Expense Claims booked against a task is shown under 'Total Expense Claim' in 
the Task Costing Section 

 

  



| Projects | 1.1 - Project Management 
 

2. Project Template 

A Project Template is a set of tasks that can automatically be populated for a new project. In 
the task, you can define the number of days from the project start date and the duration of each 
task. 

This is ideal for projects that have standardized tasks (like an ERP implementation project). 

Usage 
Step 1: Make a Project Template with the standard Tasks 
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Step 2: Make a Project from the Project Template 

 

Templated projects can be created from the Project Template or in the Project itself by setting 
the "Project Template" field for an empty task list. 



 

 

 

 

 

 

 

1.2 Topic: Time Tracking 
 

1. Salary Slip from Timesheet 
2. Sales Invoice from Timesheet 
3. Timesheet Against Work Order 
4. Timer in Timesheet 
5. Timesheet Against Project 
6. Activity Type 
7. Activity Cost 
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1. Salary Slip from Timesheet 

If salary/wages for your employees are calculated based on number of hours worked, you can 
use Timesheet to track actual hours worked, and for creating Salary Slip. 

Employee creates Timesheet 

To track actual hours employee has worked for, create Timesheet for each Employee. We 
suggest you to create Timesheet based on a payment period. For example, if you are paying 
employee on a weekly basis, create one Timesheet for an Employee for one week. However, 
you can create multiple Timesheets, and create one Salary Slip for the multiple Timesheets. 

 

Salary Structure for the Employee 

In the Salary Structure of the Employee, check field "Salary Slip Based on Timesheet". On 
checking this field, you see fields Salary Component and Hour Rate. Amount for that Salary 
Component (say Basic) will be calculated based on: 

Total Timesheet Hours * Hour Rate 

Amount directly for other Salary Components (e.g.: House Rent Allowance, Phone Allowance) 
can be defined directly. When creating Salary Slip, Amount for these Salary Component will be 
fetched as it is. 
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Create Salary Slip from Timesheet 

To create a Salary Slip against Timesheet, open Timesheet and click on "Salary Slip". 

 

In the Salary Slip, Timesheet ID will be updated. You can select more Timesheet to be paid via 
this Salary Slip. Based on the Timesheets selected, Total Working Hours will be calculated. 

Hour Rate will be fetched from the Salary Structure of an Employee. Based on Total Working 
Hours and Hour Rate, Amount will be calculated for the Salary Component based on actual 
hours worked. 

Save and Submit Salary Slip 

On Submission of Salary Slip, Timesheet's status will be updated to "Pay Slip". 



| Projects | 1.2 - Time Tracking 
 

 

Creating Salary Slip based on Timesheet will allow you to manage payment for the overtime. 

1. Employee created Timesheet for the overtime. 
2. In the Salary Structure of an Employee, set Overtime as a Salary Component to be 

calculated based on hourly basis. 
3. When creating Salary Structure for an Employee, pull Timesheet when overtime details 

are tracked. 
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2. Sales Invoice from Timesheet 

Customer can be invoiced based on total no. of hours your Employees has worked for that 
Customer. Timesheet can be used to track actual no. of hours Employee has worked. For 
example, in the IT services domain, clients are billed based on man-hour basis, where per hour 
billing cost is pre-determined. 

Timesheet 

Step 1: Create new Timesheet 

To create new Timesheet, go to: Project > Timesheet > New 

Step 2: Select Employee 

In the Employee field, only ones having active Salary Structure will be selectable. Further in the 
Salary Structure, is created for the E on the actual hours worked, Employee can create 
Timesheet. To be able to create Sales Invoice against this Timesheet, ensure Billable field is 
checked. 

 

Step 3: Activity Type 

Employee will have to select an Activity Type (like planning, site visit, repairing etc.). Costing 
and Billing Rate for each Activity can be different for each Employee. These costs can be tracked 
in the Activity Cost. On selection of Activity Type, Activity Cost is fetched from that Employee. 
Based on total Activity Cost and total no. of hours, Total Billing Amount (to the Customer) is 
calculated. 



| Projects | 1.2 - Time Tracking 
 

 

Step 4: Enter Actual Time 

In the Timesheet Details table, enter actual hours an Employee has worked for. One Timesheet 
can be used for multiple days as well. 

To be able to create Sales Invoice from the Time Sheet, ensure 'Is Billable' field is checked. 

Based on the actual hours worked and Activity Cost of an Employee, Total Billing Amount will 
be calculated for Timesheet. 

Step 5: Save and Submit 
After submitting Timesheet, you will find buttons to create Sales Invoice and Salary Slip against 
this Timesheet. 
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Create Sales Invoice from Timesheet 

Submitted Timesheet 

In the Timesheet, if "Is Billable" is checked, you will find option to create Sales Invoice against 
it. 

 

Sales Invoice 

Sales Invoice has dedicated table for the Timesheet table where Timesheet details will be 
updated. You can select more Timesheets in this table. 

Select Customer and Item 
Select Customer to be billed. Select an Item, and enter rate as the billing amount. 

Save 
After you enter all required details in the Sales Invoice, Save and Submit it. 

On submitting Sales Invoice, status of the Timesheets linked to the Sales Invoice will be 
updated as Billed. 
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3. Timesheet based on Work Order 

Creating Timesheet for Work Order helps in capacity planning for the Workstations. Also, it 
helps in tracking actual time consumed by the Workstation for completing specific operation. 

When a Work Order is submitted, based on the Planned Start Date and the availability of the 
Workstations, system schedules all operations by creating Timesheet. 

 

Let's assume we are manufacturing a mobile phone. As per the Bill of Material, time required 
for the assembly of components could be one hour. However, the actual time taken for its 
completion could be more than planned. The actual time tracking provides actual operation 
cost, hence helps in determining accurate valuation of the manufacturing item. 

Work Order 

As per the Bill of Materials of manufacturing item, following are the Operations and Workstation 
through which raw-material items are processed. 
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On submission of Work Order, Timesheet will be created automatically. 

 

Time Sheet created from Work Order 

In the Timesheet, unique row will be added for each Operation - Workstation. This allows 
operator/supervisor at the workstation to enter actual From Time and To Time taken for each 
Operation. 

After enter From Time and To Time for all the Operations, Total Hours will be calculated. 
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With updating actual time, you can also enter "Completed Qty". If all the items are not 
processed in the same Timesheet, you can create another Timesheet from the Work Order. 

 

Save and Submit Timesheet 

On the submission of Timesheet, Total Hours is calculated. Also, in the Work Order, for each 
Operation, actual Start and End Time is updated. 
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4. Timer in Timesheet 

Timesheets can be tracked against Project and Tasks along with a Timer. 

Steps to start a Timer: 

• On clicking, Start Timer, a dialog pops up and starts the timer for already present activity 
for which checkbox completed is unchecked. 

 

• If no activities are present, fill up the activity details, i.e. activity type, expected hours or 
project in the dialog itself, on clicking Start, a new row is added into the Timesheet Details 
child table and timer begins. 

• On clicking, Complete, the hours and to_time fields are updated for that particular 
activity. 
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• At any point of time, if the dialog is closed without completing the activity, on opening the 
dialog again, the timer resumes by calculating how much time has elapsed 
since from_timeof the activity. 

• If any activities are already present in the Timesheet with completed unchecked, clicking 
on Resume Timer fetches the activity and starts its timer. 

• If the time exceeds the expected_hours, an alert box appears. 
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5. Timesheet against Project and Task 

Timesheets can be tracked against Project and Tasks so that you can get reports on how much 
time was spent on each Task or Project. 

If standard working hours are set up in the Company master and the user enters from time and 
to time, the system would automatically calculate the number of hours. E.g.: standard working 
hours are set up as 8 at the company level and start time and end time are 4 days apart, the 
calculated hours would be 32. If the standard working hours are not set up, then the system 
would calculate the hours as 96 hours in this case. 

Billable Timesheet 

To bill Customer based on Timesheet, check "Is Billable" in the Timesheet created against 
Project and Task. To learn more about billing Customer from Timesheet, click here. 

User can also make invoice against timesheet by selecting the project on the invoice. System 
will fetch the records from the timesheet based on selected project, for mode detail check 
below video 

Project Costing 

When creating Timesheet, Employee will have to select an Activity Type. For each Activity Type, 
you can create an Activity Cost master. In the Activity Cost, Billing Rate and Costing rate is 
defined for each Employee. 

In the Timesheet, costing will be done based on Activity Cost multiplied with number of hours. 
Based on the Timesheet Cost, total costing will be done for the Task and Project as well. 

  

https://erpnext.com/docs/user/manual/en/projects/timesheet/sales-invoice-from-timesheet.html
https://erpnext.com/docs/user/manual/en/projects/timesheet/sales-invoice-from-timesheet.html
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6. Activity Type 

Activity Type makes a list of the different types of activities against which a Time Log can be 
made. 

 

By default, the following Activity Types are created. 

• Planning 
• Research 
• Proposal Writing 
• Execution 
• Communication 
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Activity Cost 

Activity Cost records the per-hour billing rate and costing rate of an Employee against an 
Activity Type. This rate is pulled by the system while making Time Logs. It is used for Project 
Costing. 

 

 



 

 

 

 

 

 

 

2.1 Article: Project Costing 
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1. Project Costing 

Each project has multiple task associated with it. To track actual costing of a Project, primarily 
in terms of services, user has to create Time Log based on actual time spent on Project-Task. 
Following the steps on how you can track actual service cost against Project. 

Activity Type 
Activity Type is a master of service offered by your personnel. You can add new Activity type 
from: Project > Activity Type > New 

Activity Cost 
Activity Cost is a master where you can track billing and costing rate for each Employee, and for 
each Activity Type. 

 

Time Log 
Based on Actual Time spent on the Project-Task, Employee will create a time log. 
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On selection of Activity Type in the Time Log, Billing and Costing Rate will fetched for that 
Employee from respective Activity Cost master. 

 

Multiplying these rates with total no. of Hours in the Time Log gives Costing Amount and Billing 
Amount for the specific Time Log. 

Costing in Project and Task 
Based on total Time Logs created for a specific Task, its costing will be updated in the respective 
Task master. 

 

Same way, Project master will have cost updated based on Time Log created against that 
Projects, and tasks associated with that Project. 

 

 



 

 

 

 

 

 

 

2.2 Article: Project Profitability 
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1. Project Profitability 

Project and related activities are generally active for longer time periods. While developments 
happen on the Project, there are various income and expense incurred against it. Hence, it 
becomes important to track the Profitability of a Project and ensure that you don't overspend. 

Project in Sales Transactions 
You can link a Project in all the sales transactions like Sales Order, Delivery Note, Sales Invoice, 
and Payment. Linking Project with the sales transactions will help you in tracking income 
received against that Project. 

In sales transactions, Project field is generally available in the More Information section. 

 

Project in Purchase Transactions 

The project can also be linked to the purchase transactions like Purchase Order, Purchase 
Receipt, and Purchase Invoice. 

In the purchase transactions, Project's link field is available in the Item table. This is because 
you could be procuring material for multiple Projects from the same purchase entry. 
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Budgeting against Project 

You can create Budget for a Project as well. The expense limit defined in the Budget master will 
be validated in the expense transactions. 

 

Project Profitability 

Based on the all the income and expense entries created for the Project, you can get its 
profitability by going to: Accounts > Profitability Analysis 

Filter report based on Project to check Project-wise Profitability. 

 



 

 

 

 

 

 

 

2.3 Article: Project Expenses 
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1. Project and Managing Expenses 

The Employees working on the Project incur various expenses, sometimes from their own 
pocket. In ERP+, then can claim such expenses using Expense Claim. 

In this Expense Claim, they can also select a Project for which that expense was incurred. 

Based on the Expense Claims made for a particular project, total Expense Claim Amount is 
updated in the Project master, under project costing section. 

• You can create an Expense Claims directly and link it to the Project. 

 

• Total amount of Expense Claims booked against a project is shown under 'Total Expense 
Claim' in the Project Costing Section 

 



 

 

 

 

 

 

 

2.4 Article: Project Customer Portal 
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1. Project Customer Portal 

If you are doing a Project for a Customer, then Customer will need to be updated on its progress 
on timely bases. In ERP+, since it is a Customer Portal feature, you can let Customer update 
oneself on the Project's progress via Customer Portal. 

Add User as a Website User 

For a Customer to be able to access Project from the portal, should be added as a Website User. 
A Customer can also sign up from the Login Page of your ERP+ account, using the same Email 
ID as mentioned in the Contact master. Or you can invite that User from the Contact master. 

 

Add Customer and User in Project 

In the Project master, check Customer Details section. Select a Customer and Sales Order 
associated with this Project. 
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Portal View of Project 

When a Customer login from the Portal, he/she will be able to view all the Task for that Project. 
Also, the customer will be able to update the status of the Tasks or comment when needed. 
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